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11
1	 Starten met AutoCAD

In dit hoofdstuk maken we u wegwijs in de schermindeling van AutoCAD. 

Eveneens leert u de basishandelingen die nodig zijn om AutoCAD te bedienen.

1.1 	 In dit hoofdstuk

−	 AutoCAD starten en afsluiten.
−	 De verschillende delen van de gebruikersinterface benoemen en bedienen.
−	 Werken met muis en toetsenbord.
−	 Tekeningen openen, opslaan en sluiten.
−	 Commando’s starten en beëindigen.
−	 Helpfuncties binnen AutoCAD.

1.2 	 AutoCAD starten

U kunt AutoCAD onder andere op de volgende manieren starten:

•	 Via het menu Start.
•	 Via een snelkoppeling op het bureaublad.
•	 Door een tekening vanuit Windows Verkenner te openen.

1.2.1 	 AutoCAD starten via het menu Start

Via het menu Start van Windows zoekt u in de lijst Alle programma’s naar de 
verzamelmap Autodesk. In deze map staan snelkoppelingen naar alle Auto-
CAD-versies die op uw systeem zijn geïnstalleerd. Ook vindt u hier enkele hulp-
programma’s. Kies de submap AutoCAD (LT) 2011 en vervolgens het pro-
gramma AutoCAD (LT) 2011.
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1.2.2 	 AutoCAD starten met een snelkoppeling

Tijdens de installatie is er een snelkoppeling op het bureaublad geplaatst. U 
start AutoCAD door hierop te dubbelklikken. 

1.2.3 	 AutoCAD starten via Windows Verkenner

Zoek in Windows Verkenner de tekening die u wilt openen. Dubbelklik hierop 
of klik met de rechtermuisknop en kies Open.

Oefening 1.1 De schermindeling
1	 Start AutoCAD op de manier van uw keuze.
2	 Als AutoCAD gestart is, ziet u het Welcome Screen (zie figuur 1.1). 

Figuur 1.1

Het Welcome Screen toont u onder andere de New Features Workshop. 
Hier vindt u stapsgewijs de belangrijkste nieuwe functies in AutoCAD 2011. 
Mocht u al bekend zijn met AutoCAD, dan is dit een goede manier om snel bij-
gespijkerd te worden. U kunt het Welcome Screen of de workshop op elk ge-
wenst moment nog eens bekijken door deze te openen vanuit het help-menu.

3	 Sluit het venster door op het kruisje rechtsboven in de hoek te klikken.
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1.3 	 De gebruikersinterface van AutoCAD 

De gebruikersinterface van AutoCAD 2011 heeft dezelfde uitstraling gekregen 
die u misschien herkent van Microsoft Office. 

Figuur 1.2

Om duidelijkere schermafbeeldingen te tonen wordt in dit boek zo veel moge-
lijk gebruikgemaakt van een egaal witte achtergrond. 
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Figuur 1.3

Deze gebruikersinterface is opgedeeld in een aantal hoofdonderdelen:

1.3.1 	 Titelbalk (title bar)

Helemaal bovenaan in het venster vindt u de titelbalk. Hierin staan in het mid-
den het versienummer van AutoCAD en de naam van de tekening waaraan u 
werkt.

De titelbalk biedt verder plaats aan:

AutoCAD-menu
Links in de titelbalk vindt u het AutoCAD-menu (zie figuur 1.4). Dit menu 
biedt snel toegang tot de meest voorkomende commando’s om bestanden te 
openen, op te slaan of af te drukken. 
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Figuur 1.4

Workspaces
Als u al wat langer met AutoCAD werkt krijgt u misschien de behoefte de ge-
bruikersinterface naar uw smaak en wensen aan te passen. Het is mogelijk zelf 
onderdelen aan de interface toe te voegen of bestaande onderdelen te wijzigen. 
Deze gewijzigde instellingen kunt u opslaan als een workspace.

Met behulp van deze opgeslagen workspaces is het mogelijk te kiezen tussen 
verschillende gebruikersinterfaces die passen bij verschillende werkzaam
heden. Zo zijn in AutoCAD 2011 de volgende standaard-workspaces beschik-
baar:

•	 2D Drafting & Annotation; 
•	 3D Basics  (niet in AutoCAD LT);
•	 3D Modelling (niet in AutoCAD LT);
•	 AutoCAD Classic.

De huidige schermindeling met de ribbon is opgeslagen in de 2D Drafting & 
Annotation workspace. De 3D-workspaces wijzigen de ribbon zodanig dat 
deze de benodigde 3D-tabbladen en panelen bevat.

Veel van de commando’s die u vanuit de ribbon kunt starten, vindt u ook terug 
in de menubalk en werkbalken die rondom het tekenveld kunnen worden ge-
plaatst. Veel mensen zullen in figuur 1.5 AutoCAD herkennen zoals het tot ver-
sie 2009 bekend was. Dit is de workspace AutoCAD Classic.
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Figuur 1.5

In deze basiscursus wordt gebruikgemaakt van de standaard-workspace 2D 
Drafting & Annotation.

Quick Access-werkbalk
Naast het keuzemenu voor de workspaces vindt u de Quick Access-werk-
balk. Hierin staan de meest voorkomende algemene commando’s zoals: 
Nieuw, Openen, Opslaan, Afdrukken en Ongedaan maken. 

Search menu, Subscription Center, Communication Center en 
Help menu
Rechts in de titelbalk vindt u het Search menu en het Communication Cen-
ter. Het Search menu is geoptimaliseerd om hulp te zoeken in de helpbestan-
den of op internet. Via het Communication Center wordt niet alleen uw soft-
ware up-to-date gehouden maar kunt u ook via internet artikelen lezen, tips en 
trucs, RSS-feeds en internetblogs vinden. 

1.3.2 	 Ribbon

De ribbon vervangt de vroegere werkbalken en menu’s. De belangrijkste Auto-
CAD-commando’s zijn gerangschikt in meerdere tabbladen en panelen. Ieder 
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paneel bevat de meest voor de hand liggende functies waarbij sommige pane-
len kunnen worden uitgeklapt om toegang te verkrijgen tot extra (gevorderde) 
functies. 

Door op het kleine pijltje te klikken kunt u de ribbon minimaliseren tot alleen 
nog de tabbladen, of de tabbladen en paneelnamen zichtbaar zijn. Dit alles om 
ruimte in het tekenscherm te besparen.

Klikt u met de rechtermuisknop naast het pijltje in de ribbon dan kunt u kiezen 
uit verschillende opties voor de weergave van de ribbon (zie figuur 1.6). U kunt 
aangeven in welke vorm u de ribbon wilt zien en welke tabbladen en panelen 
getoond dienen te worden. 

Figuur 1.6

U kunt er ook voor kiezen de ribbon zwevend als een palette op het scherm te 
plaatsen (undock) zoals te zien in figuur 1.7. 

Figuur 1.7

Eventueel kunt u de ribbon parkeren (anchor left/right) als een dashboard. 
Een dashboard kan met de functie Auto-hide automatisch open- of dichtklap-
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pen als u er met de muis bovenop staat of ervan af beweegt. Deze opties vindt u 
door met de rechtermuisknop te klikken in de balk van de ribbon.

Het is opnieuw mogelijk het scherm geheel naar eigen inzicht en behoefte in te 
delen. U moet ermee werken en ernaar kijken dus maak het zo comfortabel en 
vertrouwd mogelijk! Ook deze wijzigingen kunt u weer opnemen in een work-
space.

Ribbon bedienen
Wanneer u met de muis over de knoppen in de ribbon beweegt, verandert 
de kleur zodat u duidelijk kunt zien welke knop u op het punt staat te kiezen. 
Houdt u de muis stil boven een knop, dan worden de naam en een korte om-
schrijving van het commando getoond in een tooltip.

Figuur 1.8

Houdt u de muis iets langer boven de knop, dan verandert de tooltip in een Ex-
tended Tooltip. Hierin vindt u een uitgebreidere uitleg van het commando 
plus vaak een voorbeeld van de tijdens het commando te volgen stappen.

Figuur 1.9
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Enkele knoppen hebben een klein driehoekje naast of onder de afbeelding (zie 
figuur 1.10). Zodra u op dit driehoekje klikt, verschijnt er een zogenoemde fly-
out waaruit u variaties van het geselecteerde commando of soortgelijke com-
mando’s kunt kiezen. Op deze manier zijn snel meer commando’s te tonen zon-
der extra schermruimte in beslag te nemen. 

Figuur 1.10

Verschillende panelen zijn ook nog eens uit te klappen door op het driehoekje 
naast de paneelnaam te klikken. Hierin vindt u de minder vaak gebruikte en 
vaak uitgebreidere of meer complexe commando’s.

Wilt u niet dat een uitgeklapt paneel weer dichtklapt nadat u een commando 
hebt gekozen, klik dan op de punaise links naast de paneelnaam. Hiermee prikt 
u het paneel vast op het scherm.

Figuur 1.11

Tot slot vindt u in verschillende panelen een schuin pijltje rechtsonder in de 
hoek. Klikt u op dit pijltje dan opent een dialoogvenster waarin u verschillende 
instellingen kunt doen of stijlen kunt aanmaken.

De ribbon is een intelligent ding! Bij verschillende commando’s zijn zo veel op-
ties en instellingen mogelijk dat de ribbon automatisch omschakelt naar een 
bijbehorend tabblad dat normaal gesproken niet wordt getoond. Dit gebeurt 
onder andere bij het commando Multiline Text. Meer uitleg hierover volgt bij 
deze bewuste commando’s.
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1.3.3	 Tekenveld (Drawing Area)

Het overgrote deel van het venster wordt gebruikt voor het tekenveld. U mag dit 
veld beschouwen als een oneindig groot transparant vel papier waarop u uw 
tekening maakt. We noemen dit veld het Model. Op het moment dat u gaat af-
drukken kunt u gebruikmaken van Layouts. U vindt dit terug in de tabbladen 
onder het tekenveld. Meer hierover in hoofdstuk 14 en 15.

1.3.4	 Commandoregel (Command Line) 

In het onderste deel van het venster vindt u de commandoregel (zie figuur 
1.12). Hoewel deze in de huidige versie van AutoCAD niet meer continu ge-
bruikt hoeft te worden, is het een zeer belangrijk deel van het programma. In 
tegenstelling tot wat sommige mensen nog steeds denken, kan een computer 
helemaal niets zonder dat wij daartoe een opdracht geven. AutoCAD is daarin 
niet anders. Zodra u een opdracht geeft, vraagt AutoCAD u details om deze op-
dracht uit te voeren. U bent dus voortdurend interactief met het programma 
bezig. Dit hele proces is te volgen via de commandoregel. 

Figuur 1.12

De onderste regel van de commandoregel is het actieve gedeelte. Hier typt u 
commando’s, opties of gegevens in. De regels daarboven geven de commando-
geschiedenis of de instellingen van de geactiveerde commando’s aan. 

1.3.5	 Dynamic Input

AutoCAD heeft sinds versie 2006 de functie Dynamic Input. Deze functie laat 
de vraagstelling uit de commandoregels of de opties uit het snelmenu (rechter-
muisknop) naast de kruisdraad zien. We noemen dit de Dynamic Prompt (zie 
figuur 1.13). Het grootste voordeel van deze functie is dat tijdens het tekenen 
ook afmetingen direct worden weergegeven. Het werken met AutoCAD is hier-
door veel intuïtiever geworden doordat u zich concentreert op het tekenveld 
zonder telkens naar de commandoregel te hoeven kijken. Deze optie is helaas 
niet in het gehele programma doorgevoerd, dus op sommige momenten is de 
commandoregel nog onmisbaar. Bent u eenmaal gewend aan Dynamic Input, 
dan hoeft u de commandoregel nagenoeg niet meer te gebruiken en kunt u 
deze verbergen.

Bij Dynamic Input voert u maten in in de daarvoor bestemde velden. Opties 
binnen commando’s kunt u kiezen door op ↓ op uw toetsenbord te drukken.
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Figuur 1.13

In deze basiscursus zal zo veel mogelijk gebruikgemaakt worden van de nieuw-
ste mogelijkheden van AutoCAD, dus ook van Dynamic Input. Daar waar no-
dig zal expliciet naar de commandoregel worden verwezen. Om de leesbaarheid 
te vergroten zien de afbeeldingen van Dynamic Input in dit boek er iets anders 
uit dan bij u op het scherm.

1.3.6	 Statusbalk (Status Bar) 

De statusbalk bevat onder andere een groot aantal hulpmiddelen die het teke-
nen vereenvoudigen. Daarnaast kunt u coördinaten uitlezen en verschillende 
instellingen wijzigen (zie figuur 1.14). 

Figuur 1.14

Deze hulpmiddelen kunt u te allen tijde naar wens in- of uitschakelen. Dit doet 
u door met de linkermuisknop op de knoppen te klikken. Een grijze knop staat 
uit, een blauwe staat aan. De namen van de hulpmiddelen worden getoond in 
een tooltip die verschijnt als u uw muis stilhoudt boven een knop. 

Naam hulpmiddel Functie

Infer Constraints* Automatisch constraints toevoegen.

Snap Mode Volgt het ingestelde lijnraster (zie Grid).

Grid Display Toont lijnraster in het tekenveld.

Ortho Mode Beperkt de vrijheidsgraden tot hoeken van 90 graden.

Polar Tracking Beperkt de vrijheidsgraden tot de gekozen hoeken.

Object Snap Activeert vangfuncties bij puntselectie.

3D Object Snap* Activeert vangfuncties bij 3D-puntselectie.

Object Snap Tracking Geeft virtuele hulplijnen weer.

Tabel 1.1: Hulpmiddelen in de statusbalk ➨
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Naam hulpmiddel Functie

Allow Dynamic USC* Automatische tekenvlak keuze bij 3D-tekenen.

Dynamic Input Toont input naast kruisdraad.

Show/Hide Lineweight Toont lijndiktes op het tekenveld.

Show/Hide Transpa-
rency

Activeert transparantie van lagen of arceringen.

Quick Properties Toont Quick Properties paneel op het scherm.

Selection Cycling Hulpmiddel bij selecteren van overlappende objec-
ten.

Tabel 1.1 (vervolg): Hulpmiddelen in de statusbalk 

Hulpmiddelen gemarkeerd met * zijn niet beschikbaar in AutoCAD LT en wor-
den niet behandeld in deze cursus. 

1.4	 Commando’s geven, afbreken en herhalen

Soms ontstaat er wat verwarring door de vele manieren waarop het moge-
lijk is een commando te geven. Sommige commando’s kunnen op wel vier of 
vijf manieren worden geactiveerd. Er is daarbij geen goede of slechte manier.  
U kiest de manier die u het beste past. Hiervoor zullen wij bij ieder commando 
aangeven welke mogelijkheden u hebt.

De meest voorkomende mogelijkheden zijn:

•	 Klik op de knop van een commando in de ribbon of de werkbalken.
•	 Selecteer het commando uit het betreffende menu (AutoCAD Classic Work-

space)
•	 Typ het commando volledig in op de commandoregel of in de dynamic 

prompt naast de muis.
•	 Gebruik een sneltoets of toetsencombinatie.

Als voorbeeld het commando Open waarmee u tekeningen opent. De volgende 
tabel toont de verschillende manieren waarop u het commando kunt starten. 
Kies zelf de prettigste manier van werken.

Open

Ribbon:
Menu: 
Commandoregel:
Sneltoets:

Quick Access-werkbalk
File > Open…
Open
Ctrl+O

Een volgend punt voor verwarring is het beëindigen van commando’s. Sommi-
ge moeten worden beëindigd door op Enter te drukken, terwijl andere na het 
uitvoeren van een taak zichzelf beëindigen. Het verschil zit hem hierin: 
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•	 Als een handeling slechts eenmaal uitgevoerd kan worden, beëindigt het 
commando zichzelf en hoeft u niet meer op Enter te drukken.

•	 Als u een handeling binnen een commando meerdere malen kunt uitvoe-
ren, dient u het commando zelf met Enter te beëindigen.

Een goed voorbeeld hiervan zijn de commando’s Move (verplaatsen) en Copy 
(kopiëren). Verplaatst u een object, dan wordt het commando beëindigd nadat 
u het object hebt verplaatst. U kunt dus maar één keer verplaatsen. Kopieert u 
een object, dan kunt u meer dan één kopie maken. Om aan te geven dat u klaar 
bent met kopiëren beëindigt u het commando door op Enter te drukken nadat 
u de laatste kopie hebt geplaatst.

Blijf het verloop van het commando altijd volgen in de Dynamic Prompt of op 
de commandoregel. Hieruit zal altijd blijken of het commando nog actief is 
of niet. Zodra de Dynamic Prompt verdwijnt en in de commandoregel weer 
Command: staat, wacht AutoCAD op een nieuwe opdracht en is het actieve 
commando beëindigd.

In plaats van de Enter-toets mag u ook de rechtermuisknop of spatiebalk  
gebruiken om een commando te beëindigen. 

Soms start u een commando en merkt u dat u het verkeerde commando hebt 
gekozen of dat u eerst nog iets anders wilt doen. Druk maximaal driemaal op de 
Esc-toets op het toetsenbord om alles te annuleren.

Wilt u het laatst gegeven commando herhalen, druk dan op de Enter-toets of de 
spatiebalk en het laatste commando wordt direct weer geactiveerd.

1.4.1 	 Opties tijdens commando’s

Bij veel commando’s kunt u tijdens het uitvoeren van dit commando voor extra 
opties kiezen. Vaak zijn dit sub-commando’s, binnen het gekozen commando, 
die u kunt uitvoeren zonder het gekozen commando te beëindigen.

De opties zijn meestal op drie manieren te kiezen. Zie figuur 1.15 voor de opties 
tijdens het lijn-commando.

Lees de commandoregel. Hierop staan de opties tussen haken aangegeven 
[Optie]. Meestal staat de eerste letter van die optie als hoofdletter aangegeven. 
Typ de aangegeven hoofdletter(s) in en bevestig deze invoer met Enter om de 
optie te kiezen.

Klik op de rechtermuisknop. De opties worden in een schermmenu getoond 
waar u deze kunt selecteren om de optie te kiezen. Behalve de actuele opties 
toont dit menu ook nog een aantal algemene opties of hulpmiddelen.
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Figuur 1.15

Als Dynamic Input staat ingeschakeld, kunt u op het pijltje naar beneden van 
uw toetsenbord drukken. Onder de Dynamic Prompt worden dan de opties 
getoond. Deze kiest u door de gewenste optie met de muis aan te klikken.

1.4.2	 Muisknoppen en muiswiel

Het tekenen met AutoCAD gebeurt voor het grootste deel met de muis. In deze 
basiscursus wordt uitgegaan van het werken met een muis met een muiswiel 
en twee knoppen. Hebt u geen muis met een muiswiel, schaf deze dan zo snel 
mogelijk aan. Het wieltje levert u veel gemak en tijdwinst op!

Waarschijnlijk is het u al opgevallen dat de muisaanwijzer in het venster er an-
ders uitziet dan u gewend bent van de meeste Windows-programma’s. In Auto
CAD wordt de muisaanwijzer gevormd door een horizontale en verticale lijn 
met in het midden een klein blokje. We noemen deze aanwijzer de kruisdraad 
(cross-hair). Net als het symbool linksonder in de hoek van het tekenveld, het 
UCS-icon, refereert de kruisdraad aan de assen waarmee AutoCAD punten in 
de tekening vastlegt. Dit wordt uitvoerig behandeld in hoofdstuk 6.

De linkermuisknop dient voor het selecteren van menu’s en knoppen in de werk-
balken, en voor het aanwijzen van punten in het venster. Deze knop wordt ook 
gebruikt om bestaande elementen te selecteren om deze te kunnen bewerken. 
Zodra u met de kruisdraad het tekenveld verlaat, verandert deze in een pijltje.
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De rechtermuisknop werkt net als de spatiebalk als een alternatief voor de  
Enter-toets. Er is nu echter wel een verschil. Standaard staat de rechtermuis-
knop intelligent ingesteld. Een klik op de rechtermuisknop zal afhankelijk van 
waar en wanneer u klikt een andere functie hebben. Figuur 1.16 geeft daarvan 
een aantal voorbeelden.

•	 Als er geen commando actief is en u klikt met de rechtermuisknop in het 
tekenveld, zal een snelmenu worden getoond. Boven in dit snelmenu staat 
altijd Repeat… (+ laatste commando). Daaronder staan enkele opties die u 
op dat moment hebt.

Figuur 1.16

•	 Veel commando’s hebben extra opties. Klikt u met de rechtermuisknop tij-
dens een dergelijk commando, dan zal het snelmenu deze opties tonen.

•	 Als u voor een commando een selectie hebt gemaakt, dient u AutoCAD aan 
te geven wanneer u klaar bent met selecteren. Klikt u na het maken van de 
selectie met de rechtermuisknop, dan zal AutoCAD verdergaan met de vol-
gende stap van het commando. U bevestigt dus de selectie.

•	 Hebt u een selectie gemaakt zonder eerst een commando te activeren en 
klikt u vervolgens met de rechtermuisknop, dan toont het snelmenu een 
aantal bewerkingen die u direct op de selectie kunt toepassen.

U merkt het, er zijn een groot aantal, soms verwarrende, mogelijkheden. Neem 
bij de eerste oefeningen ruim de tijd om de verschillende menu’s te bestude-
ren. Door goed gebruik te maken van deze menu’s kunt u zich veel extra hande-
lingen besparen.

Het muiswiel gebruikt u om snel in de tekening te zoomen en te pannen. Door 
te zoomen kunt u details uitvergroten of juist de hele tekening in het venster 
tonen. Door te pannen verschuift u de hele tekening onder uw venster door. U 
maakt dan andere delen van de tekening zichtbaar zonder te hoeven zoomen. 
Deze functies worden in hoofdstuk 3 uitgebreid besproken.
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1.4.3	 Commando’s ongedaan maken

Fouten maken is menselijk en helaas gebeurt dat tijdens het tekenen regelma-
tig. Wees echter vooral niet bang om fouten te maken. Blijf niet te lang twijfelen 
of piekeren als u niet zeker weet of u een commando juist uitvoert. Bent u bang 
dat u niet het juiste commando hebt gekozen, probeer het dan gewoon. Het 
voordeel van een computer is dat we met één druk op de knop een actie weer 
ongedaan kunnen maken. Dus geen gedoe meer met gum of radeermesje.

Undo: het voorgaande commando ongedaan maken
Als een handeling al is uitgevoerd, kunt u het commando Undo gebruiken om 
deze handeling weer ongedaan te maken. Dat kan van alles zijn, bijvoorbeeld 
een lijn tekenen, een lijn verplaatsen of een zoomactie uitvoeren.

De functie Undo kan bij een aantal commando’s ook tijdens het commando 
gebruikt worden. Kijk in de opties binnen het commando of type de letter U 
gevolgd door Enter.

Undo

Ribbon: 
Menu: 
Commandoregel: 
Sneltoets:

Quick Access-werkbalk
Edit > Undo 
Undo 
U of Ctrl+Z

Redo: Undo-commando’s weer ongedaan maken
Met het commando Redo kunt u handelingen weer terughalen die daarvoor 
met Undo-acties ongedaan gemaakt zijn. De ongedaan gemaakte handelingen 
worden dan weer hersteld. Ook de knop van dit commando staat in de Quick 
Access-werkbalk. 

Redo

Ribbon: 
Menu: 
Commandoregel:
Sneltoets:

Quick Access-werkbalk
Edit > Redo 
Redo
Ctrl+Y

Het commando Oops
De laatste Erase-actie maakt u ongedaan met het commando Oops. Wat u het 
laatst hebt verwijderd uit de tekening, wordt dan weer teruggeplaatst. Het doet 
er niet toe of u na deze Erase-opdracht andere commando’s hebt gebruikt of 
uitgevoerd. Het commando Oops moet u intypen, er is geen knop of menu-
keuze voor.

1.5	 Helpfuncties binnen AutoCAD

Raakt u toch nog de weg kwijt binnen AutoCAD? Geen paniek! De helpfuncties 
van AutoCAD zijn zeer uitgebreid. Kreeg u vroeger nog drie dikke boeken bij de 
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software, tegenwoordig zijn die helemaal verwerkt in de helpfuncties. U kunt 
de boeken overigens nog wel aanvragen bij Autodesk.

De eenvoudigste manier om hulp bij een commando te krijgen is door gebruik 
te maken van functietoets F1.

Oefening 1.2 Helpfuncties voor het commando Line
1	 Start het commando Line.

Line

Ribbon: 
Menu: 
Commandoregel:
Sneltoets:

Home > Draw
Draw > Line
Line
L

2	 Druk op functietoets F1.

Er wordt een helpvenster in uw webbrowser geopend dat direct naar het lijn-
commando gaat. Hier kunt u lezen hoe u het commando geeft en wat de te vol-
gen stappen zijn om het commando te voltooien. Een voorbeeld van zo’n help-
venster ziet u in figuur 1.17.

Figuur 1.17

3	 Sluit de tekening.
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1.6	 Samenvatting

De eerste kennismaking met AutoCAD zit erop. Er zullen nog veel nieuwe com-
mando’s en bijbehorende oefeningen volgen. In ieder geval weet u nu waar u 
het een en ander kunt vinden. De belangrijkste punten van dit hoofdstuk:

•	 Het herkennen van de verschillende onderdelen van de AutoCAD-scherm-
indeling.

•	 Commando’s geven en afbreken.
•	 Handelingen ongedaan maken.
•	 AutoCAD-commando’s zijn op verschillende manieren te herhalen: met 

een druk op de Enter-toets, de spatiebalk of via een snelmenu dat u via een 
klik met de rechtermuisknop oproept.

•	 Op de commandoregel of in de Dynamic Input-velden verschijnen op-
drachten of vragen om de commando’s te kunnen voltooien.

•	 Druk op functietoets F1 om direct de helppagina’s van het commando waar 
u mee bezig bent op te roepen.




